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A1. SELECT XM License 
 a) Standalone workstations  
 
Overview 
This is for installations which do not use the internet or network to authenticate the 
Bentley SELECT License which is required to run STAAD.Pro. 
 
In order to complete the installation, your SELECT license file (*.XML) will be 
required.  Without this file, STAAD.Pro will operate using a trial License for only 15 
days. 
 
 
Instructions 
a) Install STAAD.Pro 
To install STAAD.Pro 2006 ensure you have logged in with an account that has 
administrative privileges.  If you are unable to log in with a suitable account, then 
contact your network administrator to login and perform the installation.  
 
Insert the CD for STAAD.Pro 2006 which should automatically run an introduction 
application from which you can start the STAAD.Pro installation.  If the introduction 
application does not begin, then use ‘My Computer’ to browse to the CD and 
double click on the file SproCD.exe which is in the root folder of the CD. 
 
Due to the importance of understanding the security requirement, the first dialog 
box requires that the file ‘QuickStart.pdf’ is viewed prior to continuing with the 
installation.  Once this has been done, click in the check box and on the Next> 
button. 
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Follow the instructions on the subsequent dialog boxes.  The following steps are 
for assistance on the more significant dialogs.  Those that are not illustrated here 
should be self explanatory.  
 
When asked for the User Name, Company Name and Serial Number, there is an 
option for confirming that you will be using a Bentley SELECT License by clicking 
in the check box titled ‘I am under Bentley Select Contract’.  This will provide the 
serial number that is required for this method of security only. 
 

 
 
When the check box is clicked, the following confirmation message box is 
displayed.   
 

 
 
 
Click on the ‘Yes’ button to confirm the situation and the serial number box will 
get populated with a number as shown. 
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Click on ‘Next’ button and the following dialog box is displayed which allows 
confirmation of the security method that is to be employed.  This should be set to 
the option ‘SELECT XM License’ and confirmed by clicking on the ‘Next’ button.   
 

 
 
 
Continue setting your individual requirements in the remainder of the dialog boxes 
to complete the installation of the STAAD.Pro files.  
 
A trial license is installed with software, which allows you to run STAAD.Pro for a 
period of up to 15 days.  Within this period you must change to your specific 
Bentley SELECT License. 
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b) Adding a Standalone License file 
 
You will need your Bentley SELECT license file (*.XML), which has been supplied.  
If you do not have it please contact your STAAD.Pro software supplier 
 
Copy the license file in your hard disk. Go to Start | Programs | STAAD.Pro 2006 | 
SELECT License Tools | SELECT License Management Tool as shown below:- 
 

 
 
If this is being set for the first time, then the following message is displayed:- 
 

 
 
Click on the ‘OK’ button and the following dialog box is displayed 
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As this is for a local license, click on the ‘Cancel’ button to cancel the Options 
dialog box and it is replaced with the License Management Tool, thus:- 
 

 
 
Click on the menu item ‘File | Import…’ to open the Import License File dialog box, 
thus:- 
 

 
 
Browse to the location of the license file (.xml) file, select it and click on the ‘Open’ 
button to import the license file.  If the file is successfully imported, the available 
licenses are displayed thus:- 
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The security is now in place.  The installation is complete and STAAD.Pro is ready 
for use. 
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 b) Networked workstations  
  a. Using a Bentley SELECT License Server 
 
Overview 
This is for installations which use a Bentley Server to authenticate the Bentley 
SELECT License, which is used to run STAAD.Pro. 
 
In order to complete the installation, the SELECT Server Name and Site Activation 
key will be required.  If you do not have this, please contact your STAAD.Pro 
software supplier.  Without this information, the installation will operate using a trial 
License for only 15 days. 
 
 
Instructions 
 
a) Install STAAD.Pro 
Follow the instructions of ‘Installing a Standalone Workstation, a) Install 
STAAD.Pro’ in the preceding section. 
 
 
b) Adding the Bentley SELECT Server activation code 
 
Go to Start | Programs | STAAD.Pro 2006 | SELECT License Tools | SELECT 
License Management Tool as shown below:- 
 

 
 
If this is being set for the first time, then the following message is displayed:- 
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Click on the ‘OK’ button and the following dialog box is displayed 
 

 
 

As this is for a Bentley SELECT Server, enter the name and Site Activation Key for 
the server that you will have been issued.  E.g.:- 
 

Server Name: licensexm.bentley.com 
Site Activation Key: 1234567890ABCDE 

 
Click on the ‘Verify’ button to confirm that the entries are correct. 
 
Click on the ‘OK’ button to accept the settings which then display the License 
Management Tool with all the licenses that are available. 
 

 
 
The security is now in place.  The installation is complete and STAAD.Pro is ready 
for use.



Section A: Installation Guide 

11

  b. Using a local SELECT License Server 
 
Overview 
This is for installations which use a local server to authenticate the Bentley 
SELECT License, which is used to run STAAD.Pro. 
 
In order to complete the installation, the SELECT Server Name and Site Activation 
key will be required.  If you do not have this, please contact your network 
administrator.  Without this information, the installation will operate using a trial 
License for only 15 days. 
 
Details of setting up the SELECT Server are covered in the next section. 
 
 
Instructions 
 
a) Install STAAD.Pro 
Follow the instructions of ‘Installing a Standalone Workstation, a) Install 
STAAD.Pro’ in the preceding section. 
 
 
b) Adding the Bentley SELECT Server activation code 
 
Go to Start | Programs | STAAD.Pro 2006 | SELECT License Tools | SELECT 
License Management Tool as shown below:- 
 

 
 
If this is being set for the first time, then the following message is displayed:- 
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Click on the ‘OK’ button and the following dialog box is displayed 
 

 
 

As this is for a Bentley SELECT Server, enter the name and Site Activation Key for 
the server that you will have been issued.  E.g.:- 
 

Server Name: LocalServerName 
Site Activation Key: 1234567890ABCDE 

 
Click on the ‘Verify’ button to confirm that the entries are correct. 
 
Click on the ‘OK’ button to accept the settings which then display the License 
Management Tool with all the licenses that are available. 
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The security is now in place.  The installation is complete and STAAD.Pro is ready 
for use.
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  c. Local License Server Installation 
 
Overview 
This is for installations which use a local server on the client network to 
authenticate the Bentley SELECT License which is required to run STAAD.Pro. 
 
Instructions 
 
1) Obtain your SELECT ID.  This will be supplied by your Bentley software 
supplier. 
 
2) Using your web browser, go to the URL:- 

http://appsnet.bentley.com/myselectcd/ 
 
3) Download the SELECT Server XM Edition 
 
4) Run this installation on the server that is to be the Bentley SELECT Server. 
 
Full details of the SELECT Server installation are included in the download. 
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A2.Bentley SELECT Configuration Tool For 
STAAD.Pro 
 
The STAAD.Pro software can have multiple codes and add on modules. The 
Bentley Select system of licensing groups these codes and modules into 
predefined packs. License for appropriate packs have to be purchased. It is 
possible to purchase a different number of licenses for each individual pack. 
 
The Bentley Select configuration tool (shown below) allows the user to select a 
combination of licenses that are likely to be accessed from a particular installation 
of STAAD.Pro on a workstation or laptop. 
 

 
 
There are three types of license options: 
 

• SELECT Server USL (Universal Structural License).   
This license allows the usage of all Bentley structural software offered 
under the USL scheme. 

• SELECT Server Product License allows the use of specific software for 
which license(s) have been purchased. 

 
To be able to select one of these, knowledge of the license type is required. This 
information is internal to your organization. 
 
The list of codes and modules shown will contain only those that are applicable to 
your organization. In the dialogue box of the configuration tool check only those 
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that are likely to be used from this installation and then click on Select. This is 
important because STAAD.Pro will use up one license of each code pack or 
module that you check here. Therefore, every time STAAD.Pro is invoked from 
this installation, the license count of each of the checked components will be 
reduced by one on the server and hence not be available to any other installation 
until this instance has exited or finished running. 
 
The ‘Accept’ button records the checked options and closes this configuration tool. 
Please not that every time you run this tool, you have to make all the selections 
afresh. The tool will not echo your previous selection(s). 
 
The ‘Settings’ button invokes the Bentley License tool. The use of this tool has 
been described earlier in this Installation guide. 
 
The ‘Close’ button will close down this configuration tool.  
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A3. Non – SELECT License 
a) New Standalone Hardlock: 

 
Please note the following points before starting the installation: 
 
1) Make sure you log in with administrative rights. 
 
2) There is a sticker attached to the CD case that contains the 
serial number for the program.  You must use the serial number 
assigned to your specific lock. Otherwise, you will n o t  be able 
to update your lock in the future. 
 
3) Insert the CD for STAAD.Pro 2006 and follow the instructions on 
the screen to install the software. Some of the dialog boxes that 
need a more detailed explanation are shown next. Others are self 
explanatory  
 

 
 
If you have an older version of STAAD.Pro installed in the machine, 
the serial number information will show up automatically in the 
previous dialog box. If STAAD.pro is being installed for the first time in 
the machine, the box will be blank. In that case you will have to enter 
the serial number provided in the CD case. 
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5) When the installation wizard asks you to select the security system 
type select Local Security. Proceed with the following steps as 
instructed by the wizard to complete the installation. 
 
6) After the installation is complete, start the program either by double- 
clicking the shortcut icon created on the desktop for STAAD.Pro 2006 
or by going to your Windows Start menu, Programs => STAAD.Pro 
2006 => STAAD.Pro 
 
7) If you are able to see the New dialog box as shown next, the installation 
was successful. 
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b) New Network License Manager: 
 
The current version of STAAD.Pro and additional suite 
products require the REI License Manager Version 4.1 or 
higher.   
If you are currently running an older version of the REI 
Network License Manager or any SentinelLM service 
version 8x supplied by any vendor, this service must be first 
stopped and then removed prior to installing the latest 
License Manager. 
 
The latest license manager can be downloaded from the 
following URL:-  

For dongled servers:- 
www.reiworld.com/upload/NetLM4.1.zip  
 
for corporateservers:- 
www.reiworld.com/upload/CorpLM4.1.zip  

 
Subsequently you may use the REI License Manager to Add 
the licenses ( for both REI and non REI products ) Please 
note that you must use REI License Manager as the 
licenses provided for the lock is only compatible with this 
customized server. 
 
Installing the REI Network License Manager on the server 
1) Make sure you are logged in with administrative rights. 
 
2) If an older version of license manager is running, it is required to stop 
and remove the existing service before starting the new installation. You 
will find a file named loadls.exe within the files that get downloaded using 
the URLS mentioned above. Double click on that file and click on the 
“Remove” button in the resulting dialog box.  
 
3) To start the installation for the License Manager, you will have to 
double click on the REILM.exe file that is also a part of the download 
mentioned before. Follow the instructions provided by the installation 
wizard. 
 
4) By default, the files will be copied to the folder C:\NETLM . Click on the 

http://www.reiworld.com/upload/NetLM4.1.zip
http://www.reiworld.com/upload/CorpLM4.1.zip
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Browse button if you want to select a different destination folder. 
 
5) The wizard will then prompt you to select the type of security device. 
Select the appropriate option which corresponds to the type of lock you 
were sent with the software. 
 
6) The installation will now ask if you want to install the license string. The 
license string is a file that is provided through email and has an extension 
of .LIC. If you did not receive the file, contact your local REI office. If you 
have the file, click on Yes.  Please ensure that the network lock (if 
provided) is connected to the machine and then browse to the location of 
your license string. 
 
*Note: If you do not have the license string with you or want to add it later 
manually, click No when prompted to add the license string. For 
instructions on adding the license string manually, see Section 5.1.1, 
steps 5 and 6. 
 
7) Once you have provided the path to your license string, click on Next.  
 
8) The installation will then add the license string  
 
Once the installation is complete, the SentinelLM service will start 
automatically. You are now ready to install STAAD.Pro 2006 on client 
machines. 
 
Installing STAAD.Pro 2006 on the client machine 
 
1) Make sure you log in with administrative rights. 
 
Note that the serial number used for installation in the client machine 
must match the serial number assigned to the network lock in order 
for the program to be able to pull the license from the server. The 
serial number is available in the CD case. 
 
2) Insert the CD for STAAD.Pro 2006 and follow the instructions on the 
screen to install the software. 
 
3) When the installation Wizard prompts you to select the security 
system, select the Network Security. 



Section A: Installation Guide 

21

 
4) Next, enter the name of the server on which the REI Network 
License Manager is running.  You will then b e  asked to provide the 
location of the .USR file. This file is also supplied in a floppy disk or 
through email along with the network license file. Proceed with 
the steps as instructed by the wizard to complete the installation. 
 
5) After the installation is complete, start the program by either double-
clicking on the desktop shortcut icon for STAAD.Pro 2006 or by going to 
your Windows Start menu, then Programs => STAAD.Pro 2006 => 
STAAD.Pro 
 
6) If you are able to see the ”New”  dialog box, then the installation was 
successful. 
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B1. Updating Hardlocks 
a) Updating from version 2004 or 2005 

 
Updating your hardlock is only necessary when 
upgrading from one version of STAAD.Pro to another, 
or if you have purchased additional components. Your 
hardlock needs to be updated only once for STAAD.Pro 
2006.  
 
This is ONLY for US customers. Customers in other 
regions should follow instructions provided by their 
local support centre 
 
1) After the installation is complete, start the 
program by either double-clicking on the 
desktop shortcut icon for STAAD.Pro 2006 
or by going to your Windows Start menu, 
then Programs => STAAD.Pro 2006 => 
STAAD.Pro 
 
2) At this point, the software will attempt to update 
your lock automatically for this new version. If you are 
connected to the internet, continue to the next step in this 
section. If you are not connected to the internet, close 
STAAD.Pro, connect to the internet, then open the program 
again. If this computer does not have internet connection, 
please stop here and skip to Section 5.5. 
 
3) If you are able to see the New dialog box, then the lock update 
was successful and you can stop here - you are now ready to 
use STAAD.Pro 2006. If the program gives you a message 
explaining that the lock is not programmed for this version, 
continue to the next step. 
 
4) From the Windows Start menu, go to 
Programs => STAAD.Pro 2006 => REI 
Application Assistant. Then go to the Internet 
Direct menu and select Update Lock.  
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The program should give you a message that the lock was 
updated successfully. If you can now open the program and 
see the New dialog box, then you can stop here - you are 
ready to use STAAD.Pro 2006.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Otherwise, refer to the following section. 
 

Continue here if the machine on which STAAD.Pro 
2006 is installed is not connected to the internet. 
 (Note ONLY for US customers) 

 
Go to the Windows Start  menu  = >  

Programs  => 
STAAD.Pro 2006  =>   

REI Application Assistant.  
 
Go to the  Tools  menu and 
select  Get Hardware Lock 
ID. The program will report a  
Hardware Lock ID. Write 
down this ID. Then go to the 
Tools menu again and select 
Get Serial Number. 
 
 

24
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The program will display a 1 8  c ha r ac t e r  serial number. Write 
this information down also. 
 
Go to a computer with internet connection. Open an internet browser, 
such as Internet Explorer, and go to the following web page: 
 

http://www.reiworld.com/updatelock 
 
5) Follow the steps o u t l i n e d  on that page.  You will be 
asked to enter the lock id and serial number. The page will 
then display a link to download a license file with an extension 
.LDF and a password.  
*Note: If the web page is unable to generate your license file, it 
will report an error. If this occurs, please contact your local REI 
office for assistance. For the users in US, send a request to 
license@reiusa.com with your company name, the hardlock 
number (found on the side of the lock) and the exact error  

message. 
 

 
6) Right click on this link and 
from the menu that appears, 
select Save Target As… Save 
this file and select ‘All Files’ for  
Save As Type. 

 
7) Write down the password given on this page. Go back to 
the computer on which STAAD.Pro 2006 was installed. Copy 
the file onto your Windows desktop. 
 
8) Open the  REI 
Application Assistant   
again   (Start   => Programs 
=> STAAD.Pro 2006 => REI 
Application Assistant).  This 
time go to the Update menu 
and select Update Hardware 
lock. 

mailto:license@reiusa.com
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9) When prompted, enter the path for the license file (.LDF) 
which you just saved on your desktop or click on the 
Browse  button to locate the file. Enter the password. 
 
10) Once you have entered the information, click on Update 
Lock. The program should give you a message that the lock 
was updated successfully. If you can now open 

STAAD.Pro 2006 and see the New dialog box, 
you can stop here - you are ready to use 
STAAD.Pro 2006. Otherwise, continue to the 
next step. 

 
11) If you still encounter problem, please contact your local REI 
office for assistance or send a request to license@reiusa.com 
with your company name, the hardlock number (found on the 
side of the lock) and the exact error message. 
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b) Updating from version 2003 or earlier 
 
All customers outside the US should follow instructions 
provided in this section to update their locks to 2006) 
 
Updating your hardlock is only necessary when 
upgrading from one version of STAAD.Pro to another, 
or if you have purchased additional components.  Your 
hardlock needs to be updated only once for STAAD.Pro 
2006. 
 
1) From the Windows Start 
menu, go to Programs => 
STAAD.Pro 2006 => REI 
Application Assistant. Go to the  
Tools  menu and select Get 
Hardware Lock ID 
The program will report a 
Hardware Lock ID. Go to the 
Tools menu again and select 
Get Serial Number. The 
program will report a 18-
character serial number.  
 
2) Customers in US need to send an email to 
license@reiusa.com with the following information: 
 
- your name 
- company name 
- the hardlock number (found on the side of the lock) 
- Hardware Lock ID number from step 5 
- program serial number from step 5 
 
Customers outside US need to send the email to their local REI 
offices 
 
3) You will need to wait for a response from the REI license 
department. 
 
4) You will receive an email which will include an attachment 
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and a password. The attachment will have the extension 
.LDF. Save this file onto your Windows desktop. 
 
5) Open the REI Application Assistant again (Start => Programs 
=> STAAD.Pro 2006 => REI Application Assistant). This time go 
to the Update menu and select Update Hardware lock. 
 
6) When prompted, enter the path for the license file (LDF) 
which you just saved onto your desktop or click on the  
Browse  button to locate the file. Also enter the password 
which you received in the email. 
 
7)   Click on 
Update    Lock.    
The program should 
give you a message 
that the lock 
was updated successfully. If you can open STAAD.Pro  2006 
and see the New dialog box, you can stop here - you are ready 
to use STAAD.Pro 2006. Otherwise, continue to the next step. 

 
8) If you encounter problem please contact your local REI 
office for assistance. For the users in US, send a request to 
license@reiusa.com with your company name, the hardlock 
number (found on the side of the lock) and the exact error 
message you are getting. Customers outside US need to 
contact their local REI office. 
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B2. Updating Network Licenses 
a) Updating from STAAD.Pro 2005 or 
earlier 

 
This is ONLY for US customers.  Customers in other 
international regions should refer to the instructions 
provided at the end of this section. 

 
Updating your network license is only necessary when 
upgrading from one version of STAAD.Pro to another, 
or if you have purchased additional components. Your 
network license needs to be updated only once for 
STAAD.Pro 2006.  

 
 If you are updating from any older version of STAAD.Pro 

 
Updating the license on the server
1) Open the folder where the REI Network License Manager 
files are located. The default location for this folder is 
C:\NETLM 
 
2) Run REIAssistant.exe. Go to the Tools menu and 
select  Get Hardware Lock ID. The program will report a 
Hardware Lock ID. Then go to the Tools menu again and 
select Get Serial Number. The program will report an 18-
character serial number. Write this information down. 
 
3) Open an internet browser, such as Internet Explorer, and 
go to the following web page: 
 

http://www.reiworld.com/updatelock 
 
4) Follow the steps on this page.  You will be asked to 
enter the information which you obtained in step 2 above. 
The page will then display a link to a license file with the 
extension .LIC and a .usr file. 
Right click on this link and from 
the menu that appears, select 
Save Target As… Save this file 
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onto your Windows desktop. 
 
*Note: If the webpage is unable to generate your license 
file, it will report an error. If this occurs, please contact your 
local REI office for assistance. For the users in US, send a 
request to license@reiusa.com with your company name, 
the hardlock number found on the side of the lock for the 
Network Locks, server ID for the Corporate License and the 
exact error  message you are getting. 
 
5) Go to the C:\NETLM folder. RunWLMAdmin.exe. On 
the left hand side under Subnet Servers, you should see a 
list of your license servers. Your existing license should be 
listed a s  a  f ea t u r e  ( s a y  N G S O F T 0 1 ) under your 
server. Right click on the feature name and remove the 
feature. 
 

 
 
6) Then right click again on the server, and go to Add Feature 
=> From a File => To Server and Its File. You will then be 
prompted to locate the .LIC file which was downloaded in step 
4 above. 
 
7) After the license string has been added, you should see the 
feature NGSOFT01 reappear in a branch below the server.  
 
Users outside the US will have to execute steps 1 and 2 
mentioned above. Instead of step 3, they need to send the 
information obtained in step 2 to their local REI office. They will 
in turn receive the .LIC file subsequent to which they can 
execute steps 5 through 9.  
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C1: Standalone Locks 
 

The following is a list of error messages that you may 
encounter while using STAAD.Pro. Each error message is 
followed by an explanation on how to troubleshoot the 
problem. If you receive an error message which is not a part 
of this list, please contact your local REI office for assistance. 

 
 

Hasp family mismatch
From the Windows Start menu, go to Programs => STAAD.Pro 
2006 => REI Application Assistant. Go to the Activate 
menu and select  Detect and Activate hardware lock. 
M ake sure that the STAAD.Pro lock is attached directly to the 
computer and that no other locks are attached. The 

program will search 
for an attached lock 
and will activate the 
lock found. 
 
 
 

 
Old Version of Lock Found
Your STAAD.Pro hardlock is not programmed for the current 
version. Refer to the section of this Installation and 
Troubleshooting Guide t i t led “Updat ing Lock or  
L icense”  for instructions on updating your hardlock. 

 
 

Security Drivers are old
Open a web browser, such as Internet Explorer, and type the 
following add r ess  in the address box 
 
www.reiworld.com/upload/REISecurityDriverFiles.zip 
 
It will prompt you to save a file on your computer. Save it onto your 
desktop. 
 
a) Open the zip file, REISecurityDriverFiles.zip, and extract the 
files into C:\Spro2006\Hardlock. You can rename or move the 
existing files having the same name to keep them as a backup. 
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b) Double click on REIAssistant.exe, or go to Start => Programs 
=> STAAD.Pro 2006 => REI Application Assistant 
 
c) Go to Uninstall => Uninstall License System 
 
d) Go to Install => Install License System 
 
Hasp License Expired
The license for the STAAD.Pro hardlock has expired. Please 
contact your local REI office to find out what is needed in order to 
reprogram your hardlock. For the users in US, send a request to 
license@reiusa.com with your company name, the hardlock 
number (found on the side of the lock) and the exact error 
message you are getting. Users outside US need to contact their 
local REI office. 
 
 

mailto:license@reiusa.com
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C2: Network Locks 
 

Network License Serial Number does not match with product
serial number
The serial number used on the client machine must 
match the serial number assigned to the network lock in 
order for the program to pull the license from the server. This 
message indicates that the client machine is using a serial 
number which is different from the serial number for the 
license on the server.  

 
On the client machine: 
From  the  Windows   
Start menu, go to  
Programs => STAAD 
. Pro 2006 => REI 
Application Assistant. Then go to the Activate menu and 
select Activate Network/Corporate License. In the 
Network License Server window that appears, check the 
box for ‘Discover Active License Server(s) in Current 

 
Subnet’ and click on the 
button Scan Network. 

 
The program should 

locate list of servers in the drop-down list. Select the server 
which is running the REI Network License Manager. Then 
click on the button Scan For Installed Licenses. In the 
list that appears for Available License(s), locate the 
feature called NGSOFT01. Select this license and click on 
the Select button. 

 
Start STAAD.Pro 2006. The program should now open 
properly and you should see the New dialog box. 
 
If any of the above steps do not provide adequate results, or 
activating the new license does not resolve the problem, 
please contact your local REI office for assistance. For the 
users in US, send a request to license@reiusa.com with your 
company name, the hardlock number (found on the side of 

mailto:license@reiusa.com
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the lock) and the exact error message you are getting. Users 
outside the US need to contact their local REI office.  
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C3: SELECT based license 
 
Select License Information is not yet configured or 
incomplete
 
The above message means that the SELECT server has not 
been configured or license information is incomplete.  To 
rectify this error go to Start | Programs | STAAD.Pro 2006 | 
SELECT License Tools | SELECT License Management Tool  
 
The License Management Tool dialog box will come up as shown 
next. 

 

 
 

Click on OK and the following dialog box is displayed:- 
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You will need to key in the Server Name and the Site 
Activation Key. After typing in those information, click on Verify 
and you will get a message verifying the server name and the 
activation key. You will also be able to see the available 
licenses  
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www.reiworld.com 

To visit our FAQ/Knowledge Base, click on the icon: 
 

 
 
 
or go to the following web address: 
http://www.reiworld.com/Support/Pro/Faqs.asp
 

 To visit our Discussion Group page, click on the 
icon: 

 
 
 
 
 
 
or go to the following web address: 
http://www.reiworld.com/Support/Pro/Discussion.asp
 
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~  
To visit our Tutorials and Demos page, click on the icon: 

 
 
 
 
 
 
or go to the following web address: 
http://www.reiworld.com/Product/AllDemo.asp
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